
Guide Calc
6.4

Chapitre 5
Utiliser des éléments 
graphiques





Droits d’auteur

Ce document est protégé par Copyright © 2019 par l’Équipe de Documentation de LibreOffice. Les
contributeurs sont nommés ci-dessous. Vous pouvez le distribuer et/ou le modifier sous les termes 
de la Licence Publique Générale GNU (https://www.gnu.org/licenses/gpl.html), version 3 ou ulté-
rieure, ou de la Licence Creative Commons Attribution
 (https://creativecommons.org/licenses/by/4.0/), version 4.0 ou ultérieure.

Toutes les marques déposées citées dans ce guide appartiennent à leurs légitimes propriétaires.

Contributeurs

Ce chapitre est une adaptation mise à jour du Guide Calc de LibreOffice 6.2.

Ont contribué à cette édition

Steve Fanning Leo Moons Kees Kriek

Ont contribué aux éditions précédentes

Barbara Duprey Jean Hollis Weber John A Smith
Peter Schofield Christian Chenal Martin Saffron
Drew Jensen Kees Kriek

Traduction

De cette édition

Traducteurs Jean-Luc Vandemeulebroucke
Relecteurs Philippe Clément

Des éditions précédentes

Traducteurs Jean-Luc Vandemeulebroucke Christian Chenal
Relecteurs Philippe Clément François Bégasse

Retours

Veuillez adresser tout commentaire ou suggestion concernant ce document à la liste de diffusion 
de l’Équipe de Documentation : doc@fr.libreoffice.org

Remarque

tout ce que vous envoyez à la liste de diffusion, y compris votre adresse mail et toute autre 
information personnelle incluse dans le message, est archivé publiquement et ne peut pas 
être effacé.

Date de publication et version du logiciel

Publié en mai 2021. Basé sur LibreOffice 6.4.

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr

mailto:doc@fr.libreoffice.org
https://creativecommons.org/licenses/by/4.0/
https://www.gnu.org/licenses/gpl.html


Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Control+clic ou clic droit 
selon la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

Ctrl+Q ⌘+Q Quitter LibreOffice

F11 ⌘+T Ouvre l’onglet Styles du volet latéral

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Introduction

Calc est souvent utilisé pour présenter et analyser des données et faire des budgets et des prévi-
sions. Les éléments graphiques peuvent transformer un document quelconque en un document 
dont on se souvient. Calc peut importer différents formats de fichiers vectoriels (dessin de lignes) 
et matriciels (bitmap). Les formats graphiques les plus couramment utilisés sont GIF, JPG, PNG et 
BMP. Voir l’aide pour la liste complète des formats que Calc peut importer.

Les éléments graphiques dans Calc peuvent être regroupés en trois types :

• les fichiers d’image, comme les photos, les dessins et les images scannées ;

• les schémas créés avec les outils de dessin de LibreOffice ;

• les diagrammes et graphiques créés par les fonctions Diagramme de LibreOffice.

Ce chapitre couvre les images et les diagrammes. Les diagrammes et graphiques sont décrits 
Chapitre 3, Créer des diagrammes et des graphiques.

L’usage des éléments graphiques dans Calc est très similaire à celui qui en est fait dans d’autres 
composants de LibreOffice. Pour une description plus détaillée, veuillez vous reporter au Guide du
Débutant ou au Guide Draw.

Remarque

Dans LibreOffice, les termes éléments graphiques et images se réfèrent à la fois aux images
matricielles et aux objets dessinés. Le mot image est souvent utilisé pour se référer aux 
images matricielles et autres éléments graphiques qui ne sont pas des objets dessinés.

Ajouter des images à un classeur

Des images, comme un logo de société ou une photographie, sont probablement le type d’élément
graphique que l’on ajoute le plus souvent à un classeur. Elles peuvent être téléchargées sur inter-
net, scannées, créées avec un programme graphique, prises avec un appareil photo numérique ou
provenir de la galerie.

Insérer un fichier d’image

Quand une image est stockée dans un fichier sur l’ordinateur, vous pouvez l’insérer dans un clas-
seur de LibreOffice grâce à l’une des méthodes suivantes.

Par glisser-déposer

 1) Ouvrez le navigateur de fichiers et recherchez l’image que vous voulez insérer.

 2) Faites glisser cette image dans le document de LibreOffice et déposez-la où vous voulez la 
voir apparaître. Pendant que vous faites glisser l’image, le curseur change d’aspect lors d’un 
glisser-déposer (avec le symbole + à sa base).

Cette méthode incorpore une copie du fichier d’image dans le document. Pour lier le fichier au lieu 
de l’incorporer, maintenez appuyées les touches Ctrl+Maj pendant que vous faites glisser 
l’image. Voir « Lier ou incorporer un fichier d’image », page 2 pour plus d’informations.
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Avec la boîte de dialogue Insérer une image

 1) Cliquez dans le classeur là où vous désirez que l’image apparaisse.

 2) Choisissez Insertion > Image dans la barre de menu.

 3) Dans la boîte de dialogue Insérer une image (Figure 1), recherchez l’image à insérer et sé-
lectionnez-la.

 4) Une option se trouve en bas de la boîte de dialogue qui permet de lier l’image au classeur. 
Voir « Lier ou incorporer un fichier d’image » ci-dessous pour l’utilisation de l’option Lier.

 5) Cliquez sur Ouvrir. Le fichier est inséré dans le classeur en tant qu’image flottante, ancrée à
la cellule où était placé le curseur.

Figure 1 : La boîte de dialogue Insérer une image.

Remarque

Si vous avez choisi de lier l’image, Calc peut ouvrir une boîte de dialogue de confirmation 
avec des options qui vous permettent de continuer à lier l’image ou de l’incorporer à la 
place. Une autre option de cette boîte de dialogue vous permet d’empêcher son affichage à 
l’avenir.

Lier ou incorporer un fichier d’image

Incorporer une image à un classeur en fait un élément permanent du fichier du classeur. Les chan-
gements que vous effectuerez sur l’image incorporée n’apparaîtront que dans le classeur ; l’image 
originale demeurera inchangée.

Si l’option Lier est cochée dans la boîte de dialogue Insérer une image ou, si vous appuyez sur 
Ctrl+Maj pendant une opération de glisser-déposer, Calc crée un lien vers le fichier qui contient 
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l’image au lieu d’en enregistrer une copie dans le document. Il en résulte que l’image s’affiche 
dans le document mais, quand on enregistre celui-ci, il ne contient qu’une référence au fichier 
image et non l’image elle-même. Le document et l’image restent deux fichiers séparés qui ne sont 
fusionnés qu’au moment où vous ouvrez le document.

Lier une image présente deux avantages et un inconvénient.

• Avantage : vous pouvez modifier le fichier image séparément sans charger le classeur, car 
le lien vers le fichier reste valide et l’image modifiée apparaîtra la prochaine fois que vous 
ouvrirez celui-ci. Cela peut constituer un gros avantage si vous (ou quelqu’un d’autre, peut-
être un artiste en graphisme) mettez à jour les images.

• Avantage : la liaison peut réduire la taille du document enregistré, car le fichier image n’est 
pas lui-même inclus. La taille du fichier n’est normalement plus un problème sur les ordina-
teurs modernes et Calc a la capacité d’en gérer facilement de grande taille.

• Inconvénient : Si vous envoyez le document à quelqu’un d’autre, ou si vous le déplacez 
vers un autre ordinateur, vous devez aussi envoyer les fichiers d’images et conserver la 
même structure ou celui qui recevra le document ne pourra pas voir les images liées. Par 
exemple, vous devez placer les images dans un sous-dossier appelé Images (dans le dos-
sier qui contient le document) ; le destinataire du fichier devra mettre les images dans un 
sous-dossier de même nom et situé dans le même dossier que le classeur.

Remarque

Quand vous insérez plusieurs fois la même image dans un document, il peut sembler inté-
ressant de les lier. Ce n’est cependant pas utile, car LibreOffice n’incorpore qu’une seule co-
pie du fichier d’image dans le document. Supprimer une ou plusieurs copies n’affecte pas 
les autres copies du même fichier.

Incorporer des images liées

Si vous avez initialement lié des images, vous pouvez facilement en incorporer une ou plusieurs 
par la suite si vous le désirez. Pour cela :

 1) Ouvrez le classeur dans Calc.

 2) Sélectionnez Édition > Liens vers des fichiers externes dans la barre de menu pour ouvrir
la boîte de dialogue Éditer les liens.

 3) La boîte de dialogue Éditer les liens (Figure 2) montre tous les fichiers liés. Dans la liste Fi-
chier source, sélectionnez ceux que vous voulez faire passer de l’état lié à l’état incorporé.

 4) Cliquez sur le bouton Déconnecter, puis sur OK dans le message de confirmation.

Remarque

La transformation dans l’autre sens, de l’état incorporé à l’état lié, n’est pas aussi simple : 
vous devez effacer et réinsérer chaque image, une par une, en cochant l’option Lier pour 
chacune.
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Figure 2 : La boîte de dialogue Éditer les liens.

Insérer une image du presse-papier

Grâce au presse-papier, vous pouvez copier, dans un classeur Calc, des images provenant d’un 
autre document de LibreOffice ou d’autres programmes. Pour cela :

 1) Ouvrez à la fois le document source et le document cible.

 2) Dans le document source, copiez l’image dans le presse-papier selon la méthode la plus 
adaptée à vos habitudes et au programme utilisé.

 3) Passez au document cible. Cliquez pour positionner le curseur à l’endroit où l’image doit être
insérée. Appuyez sur Ctrl+V , choisissez Coller dans le menu Édition ou le menu contex-
tuel après un clic droit ou cliquez sur l’icône Coller  dans la barre d’outils Standard pour 
insérer l’image.

! Attention

Si l’application à partir de laquelle l’image est copiée est fermée avant que l’image soit col-
lée dans la cible, il se peut que l’image stockée dans le presse-papier soit perdue.

Insérer une image avec un scanner

Si un scanner est connecté à votre ordinateur, LibreOffice peut appeler l’application du scanner et 
insérer l’élément scanné dans le document en tant qu’image. Pour commencer, placez le curseur à
l’endroit où vous désirez insérer l’image et sélectionnez le menu Insertion > Média > Scanner > 
Sélectionner la source. Sélectionnez le scanner dans la liste qui présente tous les appareils dis-
ponibles. Après ce choix, sélectionnez le menu Insertion > Média > Scanner > Acquérir. Cette 
action ouvre le logiciel d’acquisition d’image qui vous permet d’ajuster les réglages de qualité, de 
taille et autres paramètres de votre image. Quand vous quittez ce logiciel, l’image scannée est 
transmise à LibreOffice qui la colle à l’emplacement choisi.
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Bien que cette méthode soit simple et rapide, il est peu probable qu’elle produise une image de 
haute qualité et de la taille correcte. Vous pouvez obtenir de meilleurs résultats en transmettant 
l’image scannée à un programme de retouche d’image pour l’améliorer avant d’insérer le résultat 
dans Calc.

Insérer une image de la Galerie

La Galerie (Figure 3) offre une façon pratique de grouper des objets réutilisables tels que des 
images et des sons que vous pouvez insérer dans vos documents. Elle est disponible dans tous 
les composants de LibreOffice. Vous pouvez y ajouter vos propres images tout comme utiliser 
celles proposées par LibreOffice. Pour plus d’informations, voyez le chapitre 11, Images et dessins
du Guide du Débutant.

Figure 3 : La Galerie dans le volet latéral.

Pour insérer un objet :

 1) Ouvrez la Galerie, soit en cliquant sur son icône ( ) dans le volet latéral soit en sélection-
nant le menu Affichage > Galerie.

 2) Choisissez un thème.

 3) Sélectionnez un objet par un clic unique.

 4) Pour incorporer l’objet dans le document : faites glisser et déposez l’image dans le docu-
ment.

Vous pouvez aussi faire un clic droit sur l’objet et sélectionner Insérer dans le menu contex-
tuel. Dans ce cas, l’image sera positionnée selon les cellules sélectionnées dans le classeur.

Remarque

Pour lier l’objet au document : faites glisser et déposez l’objet dans le document, tout en ap-
puyant sur les touches Maj et Ctrl.
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Modifier des images

Quand vous insérez une image, vous pouvez avoir besoin de la modifier pour l’adapter au docu-
ment. Les modifications effectuées dans Calc n’affectent pas l’image d’origine, qu’elle soit incorpo-
rée ou liée.

Calc offre plusieurs outils de travail sur les images. Ils suffisent pour les nécessités quotidiennes 
de la plupart des utilisateurs. Mais, pour des résultats professionnels, il vaut généralement mieux 
utiliser Draw ou un programme de traitement d’image tel que GIMP pour les modifier (par exemple,
pour recadrer, changer la taille, faire tourner l’image ou en modifier la couleur) puis insérer le résul-
tat dans Writer. GIMP est un programme de traitement d’image open source qui peut être téléchar-
gé à l’adresse https://www.gimp.org/downloads/.

Utiliser la barre d’outils Image

Quand vous insérez une image ou que vous en sélectionnez une déjà présente dans le document, 
la barre d’outils Image apparaît à la place de la barre d’outils Formatage. Si elle n’apparaît pas, sé-
lectionnez Affichage > Barres d’outils > Image dans la barre de menu. Les outils qu’elle propose
sont décrits ci-dessous.

Remarque

Les modifications des propriétés d’une image n’affectent que la façon dont elle est affichée 
et imprimée. Le fichier de l’image originale reste inchangé.

Figure 4 : La barre d’outils Image

Ancre 
Vous avez le choix d’ancrer l’image à la cellule (avec ou sans redimensionnement) ou à la 
page. Voir « Ancrer les images », page 10.

Aligner 
Si plusieurs images sont sélectionnées, vous pouvez ajuster leur alignement horizontal et 
vertical les unes par rapport aux autres. Voir « Aligner les images », page 11.

À l’avant , Vers l’avant , Vers l’arrière , À l’arrière , Au premier plan , À l’arrière-
plan 

Six boutons qui contrôlent l’empilement (l’ordre d’affichage) des images. Voir « Disposer les 
images », page 10.

Style, Largeur, Couleur de ligne 
Vous pouvez paramétrer ici les attributs de la bordure autour de l’image.

Style, Couleur de remplissage 
Vous pouvez définir ici la façon dont l’arrière-plan de la zone contenant sera rempli (couleur, 
dégradé, hachures, etc.). Cela ne concerne pas l’image elle-même : le résultat est visible à 
travers les zones de l’image dont la transparence est assez élevée. Voir le Guide Draw pour 
plus d’informations sur le paramétrage de cette zone.
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Ombre 
Cliquez pour dessiner (ou supprimer) un effet d’ombre par défaut autour de l’image. Pour pa-
ramétrer cet effet, ouvrez l’onglet Ombre de la boîte de dialogue Remplissage (Format > 
Objet > Remplissage).

Filtrer 
Ce bouton ouvre une palette de filtres qui permettent d’appliquer des effets simples à 
l’image. Voir le Guide Draw pour plus d’informations sur les filtres.

Mode d’image 
Cette liste déroulante permet de transformer une image en couleur en image en niveaux de 
gris, noir et blanc, ou filigrane. Cet effet n’affecte que l’affichage et l’impression de l’image 
dont l’original n’est pas modifié.

Rogner Image 
Appuyez sur ce bouton pour faire apparaître des poignées de rognage autour de l’image que
vous pouvez déplacer pour masquer une partie du bord de l’image.

Refléter verticalement , Refléter horizontalement 
Cliquez sur ces boutons pour retourner l’image dans le sens horizontal ou vertical.

Pivoter 
Appuyez sur ce bouton pour faire apparaître des poignées qui permettent de faire
tourner l’image.

Transparence 
Ajustez ici le degré de transparence de l’image de 0 % (opaque) à 100 % (totale-
ment transparente).

Barre d’outils Couleur 
Ce bouton ouvre une barre d’outils où vous pouvez ajuster les valeurs de rouge,
vert et bleu de l’image, ainsi que sa luminosité, son contraste et son gamma.

Utiliser l’onglet Propriétés du volet latéral

Certains réglages de la barre d’outils Image sont aussi disponibles dans l’onglet Propriétés du vo-
let latéral quand une image est sélectionnée. Parmi ceux-ci, les paramètres de couleurs, de lignes 
et de transparence.

Ajouter du texte

Il est possible d’ajouter du texte à une image ou à un objet de dessin. Il suivra l’image quand elle 
sera repositionnée. Pour plus d’informations sur l’ajout de texte aux images, voyez le Guide Draw.

 1) Faites un double-clic sur l’image. Le curseur de texte clignote en son centre. La barre d’outils
Formatage du texte s’ouvre automatiquement à la place de la barre d’outils Formatage.

Figure 5 : La barre d’outils Formatage de texte pour les images.
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 2) Tapez votre texte et utilisez les outils de la barre pour le mettre en forme. La plupart d’entre 
eux sont identiques à ceux qui permettent de formater le texte dans les cellules.

 3) Pour ajuster la position du texte et son apparence dans l’image, faites un clic droit sur le 
texte dans l’image et sélectionnez Texte dans le menu contextuel pour ouvrir la boîte de dia-
logue Texte (Figure 6).

Figure 6 : La boîte de dialogue Texte pour le texte des images.

 4) Apportez les modifications souhaitées et cliquez sur OK pour refermer la boîte de dialogue.

Placer, redimensionner et disposer les images

Avec la souris

Pour déplacer une image à un nouvel emplacement de votre classeur, cliquez sur celle-ci et tirez-
la à sa nouvelle position. Elle conservera son ancrage précédent (À la cellule, À la cellule (redi-
mensionner avec la cellule) ou À la page).

Pour redimensionner une image :

 1) Cliquez sur l’image pour afficher les poignées de sélection.

 2) Placer le pointeur de la souris au-dessus de l’une d’elles ; il change de forme pour donner 
une représentation visuelle de la direction du redimensionnement. Les poignées des coins 
permettent de modifier les deux dimensions simultanément, celles des milieux des côtés 
n’autorisent de changer qu’une dimension à la fois.

 3) Cliquez et tirez pour modifier la taille de l’image.

Conseil

Si vous tirez les poignées de coin, les proportions sont conservées par défaut. Pour les mo-
difier, appuyez sur la touche Maj en tirant. C’est l’inverse pour les poignées des milieux des 
côtés : proportions non conservées par défaut, appui sur Maj pour les conserver.
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Avec la boîte de dialogue Position et taille.

Pour définir une position et taille précise d’une image, sélectionnez-la puis choisissez Format > 
Objet > Position et taille dans la barre de menu, ou faites un clic droit sur l’image et choisissez 
Position et taille dans le menu contextuel.

Dans l’onglet Position et taille (Figure 7), vous pouvez définir ces valeurs :

Position
Cette section définit l’emplacement de l’image sélectionnée dans le classeur.

– Position X définit la distance horizontale entre le bord gauche de la colonne A et le point 
de base choisi.

– Position Y définit la distance verticale entre le bord supérieur de la ligne 1 et le point de 
base choisi.

– Point de base : spécifiez ici le point de base dont les coordonnées seront affichées et mo-
difiées dans les deux champs précédents.

Taille
Cette section définit la largeur et la hauteur de l’image. Si vous les modifiez, le point de base 
choisi restera fixe et les autres sommets seront déplacés pour obtenir les dimensions vou-
lues.

Protéger
Cochez ces options pour éviter la modification accidentelle de la position ou des dimensions 
de l’image.

Les unités de mesure utilisées pour les coordonnées et la taille de l’image sont définies dans l’op-
tion Unité de mesure de la page LibreOffice Calc – Général de la boîte de dialogue Options (Outils
> Options > LibreOffice Calc > Unité de mesure).

Figure 7 : La boîte de dialogue Position et taille.

Placer, redimensionner et disposer les images | 9



L’emplacement pas défaut du point de base est le coin supérieur gauche de l’image. Vous pouvez 
le modifier temporairement pour simplifier le positionnement et le changement de dimension en cli-
quant sur l’un des huit autres points. Ce changement de point de base n’est pris en compte que 
jusqu’à la fermeture de la boîte de dialogue (ou le choix d’un autre point de base). À l’ouverture 
suivante de la boîte de dialogue, le point de base sera de nouveau le coin supérieur gauche.

Vous pouvez aussi faire tourner et incliner une image, grâce aux onglets Rotation et Inclinaison et 
rayon d’angle. Voyez le Guide Draw pour plus de détails.

Disposer les images

Chaque image que vous placez dans un classeur est empilée sur les précédentes, qu’elles se re-
couvrent ou pas. Utiliser les commandes de positionnement pour modifier l’ordre d’empilement des
images. Il n’est pas possible de modifier l’ordre d’empilement du texte.

 1) Sélectionner l’image que vous désirez modifier.

 2) Choisissez Format > Positionner dans la barre de menu ou faites un clic droit sur l’image et
choisissez Positionner dans le menu contextuel. Cliquez ensuite sur une des entrées du 
sous-menu, décrites ci-dessous.

 3) Vous pouvez aussi cliquer sur un des icônes de la barre d’outils Image (voir page 6).

Les possibilités de positionnement de l’image sont les suivantes :

Envoyer à l’avant
Déplacer l’image sélectionnée au sommet de la pile d’images pour qu’elle soit devant toutes 
les autres.

Vers l’avant
Monter l’image sélectionnée d’un niveau et la faire passer devant celle qui était au-dessus 
d’elle.

Vers l’arrière
Descendre l’image sélectionnée d’un niveau et la faire passer derrière celle qui était sous 
elle.

Envoyer à l’arrière
Déplacer l’image sélectionnée en bas de la pile d’images pour qu’elle soit derrière toutes les 
autres.

Au premier plan
Déplacer l’image sélectionnée devant les cellules et le texte qu’elles contiennent.

À l’arrière-plan
Déplacer l’image sélectionnée derrière la grille de cellules et le texte qu’elles contiennent. 
Pour la sélectionner de nouveau, dans le but de la modifier ou de la remplacer, il faut utiliser 
le navigateur. Les autres méthodes de sélection, avec la souris par exemple, ne fonctionnent
pas.

Ancrer les images

Ancrer une image lui permet de conserver sa position par rapport aux autres éléments.
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À la page
Ancrez une image à la page pour lui donner une position spécifique. Elle ne bouge pas 
quand des cellules sont ajoutées ou supprimées et conserve sa position dans la page où elle
a été placée.

À la cellule
Ancrez une image à la cellule pour être certain qu’elle reste avec le contenu auquel elle a été
ancrée. Si elle est ancrée à la cellule B10 et qu’une ligne est insérée au-dessus de la ligne 
10, l’image sera ancrée à la cellule B11.

À la cellule (redimensionner avec la cellule)
Cette option est semblable à la précédente avec la propriété supplémentaire que les dimen-
sions de l’image sont modifiées en même temps que celles de la cellule à laquelle elle est 
ancrée.

Pour ancrer une image ou modifier le type d’ancrage appliqué :

• Sélectionnez Format > Ancre > À la page, À la cellule ou À la cellule (redimensionner 
avec la cellule) dans la barre de menu ou faite un clic droit sur l’image puis choisissez 
Ancre > À la page, À la cellule ou À la cellule (redimensionner avec la cellule) dans le 
menu contextuel.

• Vous pouvez aussi cliquer sur l’icône Ancre  dans la barre d’outils Image puis choisir À la
page, À la cellule ou À la cellule (redimensionner avec la cellule) dans la liste dérou-
lante.

Aligner les images

Quand plusieurs images sont placées dans un classeur, vous pouvez les aligner pour obtenir un 
aspect plus professionnel. Vous disposez de trois options d’alignement horizontal (à gauche, cen-
tré, à droite) et de trois autres pour l’alignement vertical (en haut, centre, en bas).

 1) Sélectionnez toutes les images à aligner (sélectionnez la première puis appuyez sur Maj en 
sélectionnant les suivantes).

 2) Choisissez Format > Aligner dans la barre de menu ou faites un clic droit sur une image et 
choisissez Aligner dans le menu contextuel. Vous pouvez aussi cliquer sur le bouton Ali-
gner  dans la barre d’outils Image.

 3) Choisissez ensuite l’option à appliquer.

Grouper et dissocier des images

Pour grouper plusieurs images et qu’elles ne forment qu’un seul objet dans le classeur :

 1) Sélectionnez toutes les images à grouper (sélectionnez la première puis appuyez sur Maj en
sélectionnant les suivantes).

 2) Choisissez Format > Groupe > Grouper dans la barre de menu ou faites un clic droit sur 
une image et choisissez Grouper dans le menu contextuel.

Pour dissocier les images d’un groupe :

 1) Sélectionnez le groupe d’images à dissocier.
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 2) Choisissez Format > Groupe > Dissocier dans la barre de menu ou faites un clic droit sur 
le groupe et choisissez Dissocier dans le menu contextuel.

Pour éditer une image dans un groupe :

 1) Sélectionnez le groupe où se trouve l’image.

 2) Choisissez Format > Groupe > Entrer dans le groupe dans la barre de menu ou faites un 
clic droit sur le groupe et choisissez Entrer dans le groupe dans le menu contextuel.

 3) Sélectionnez l’image dans le groupe et apportez-lui les modifications souhaitées.

 4) Choisissez Format > Groupe > Quitter le groupe dans la barre de menu ou faites un clic 
droit sur une image du groupe et choisissez Quitter le groupe dans le menu contextuel.

Utiliser les outils de dessin de LibreOffice

Calc, comme tous les autres composants de LibreOffice, dispose d’une gamme d’outils pour créer 
des dessins, comme des diagrammes simples à l’aide de rectangles, cercles, lignes, texte et 
autres formes. Vous pouvez grouper plusieurs objets de dessin pour être certain qu’ils conservent 
leurs positions relatives et leurs proportions si vous les déplacez ou les redimensionnez.

Vous pouvez aussi vous servir des outils de dessin pour annoter des photographies, des captures 
d’écran ou autres illustrations produites par d’autres programmes, mais ce n’est pas recommandé. 
Si vous devez créer ce type de dessin complexe, le mieux est d’utiliser LibreOffice Draw puis d’in-
sérer le dessin produit dans votre classeur. Pour une présentation plus détaillée, voir le Guide 
Draw.

La barre d’outils Dessin

Pour commencer à utiliser les outils de dessin, affichez la barre d’outils Dessin en cliquant sur Affi-
chage > Barres d’outils > Dessin. Elle apparaît, par défaut, en bas du classeur. Si vous envisa-
gez d’utiliser régulièrement les outils de dessin, vous pouvez détacher la barre d’outils et la placer 
à un emplacement pratique sur la fenêtre.

Une fois ouverte, elle offre l’ensemble d’outils par défaut visible sur la Figure 8. Survolez un bouton
avec le pointeur de la souris pour afficher une infobulle qui décrit sa fonction. Ceux qui disposent 
d’une petite flèche à leur droite ouvrent une palette d’outils. Pour ajouter des outils supplémen-
taires à la barre d’outils Dessin, faites un clic droit sur un des boutons et sélectionnez Boutons vi-
sibles dans le menu contextuel.

Pour utiliser un outil de dessin :

 1) Cliquez dans le document à l’endroit où vous voulez ancrer le dessin. Vous pouvez modifier 
l’ancrage plus tard si nécessaire.

 2) Choisissez un outil dans la barre d’outils Dessin (Figure 8). Le pointeur de la souris change 
selon la fonction de dessin choisie pour ressembler à celui-ci pour l’outil rectangle : . La 
barre d’outils Propriétés de l’objet de dessin (Figure 9) s’ouvre (par défaut à la place de la 
barre d’outils Formatage).

 3) Déplacer la mire du pointeur à l’endroit du document où vous voulez voir apparaître le dessin
puis cliquez et tirez pour créer l’objet. Relâchez le bouton de la souris. La fonction sélection-
née reste active pour que vous puissiez dessiner un autre objet du même type.
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 4) Pour désélectionner l’outil, appuyez sur la touche Échap ou cliquez sur l’icône Sélectionner 
( ) de la barre d’outils Dessin.

 5) Vous pouvez alors modifier les propriétés (couleur de remplissage, type et épaisseur de 
ligne, ancrage, etc.) de l’objet de dessin en utilisant soit la barre d’outils Propriétés de l’objet 
de dessin (Figure 9), soit les choix et les boîtes de dialogue auxquels vous accédez par un 
clic droit sur cet objet, soit par l’onglet Propriétés du volet latéral.

Sélection Insérer une ligne Ligne avec flèche à la fin

Ligne à main levée Rectangle Rectangle arrondi

Carré Ellipse Cercle

Triangle isocèle Triangle rectangle Insérer des formes de base

Symboles Flèches Organigramme

Étoiles Légendes Légendes

Insérer une zone de texte Fontwork Points

(Des)activer l’extrusion

Figure 8 : La barre d’outils Dessin.

Définir les propriétés des objets de dessin

Pour plus d’informations sur les propriétés des objets de dessin, voyez le Guide Draw.

Vous pouvez définir des valeurs par défaut d’un objet de dessin avant de commencer à dessiner. 
Celles-ci ne s’appliquent qu’au classeur ouvert et à la session en cours. Elles ne sont pas enregis-
trées quand vous fermez le document. Elles ne s’appliquent qu’aux objets de dessin.

Pour définir les propriétés d’un dessin avant de le tracer :

 1) Dans la barre d’outils Dessin (Figure 8), cliquez sur l’outil Sélectionner .

 2) Dans la barre d’outils Propriétés de l’objet de dessin (Figure 9), cliquez sur les icônes des 
propriétés (encadrées en vert) et choisissez les valeurs que vous désirez pour celles-ci.

Figure 9 : La barre d’outils Propriétés de l’objet de dessin.
Les fonctions de gestion des propriétés proprement dites sont encadrées en vert.

 3) Quand vous avez dessiné un objet ou que vous avez groupé celui-ci avec un autre, les 
autres propriétés deviennent actives et certaines sont aussi disponibles dans l’onglet Pro-
priétés du volet latéral (Figure 10).

Vous pouvez modifier les propriétés d’un objet de dessin existant (couleur de remplissage, type et 
épaisseur de ligne, ancrage, etc.) grâce à la barre d’outils Propriétés de l’objet de dessin (Figure 
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9), à l’onglet Propriétés du volet latéral ou au menu contextuel qui s’ouvre par un clic droit sur l’ob-
jet.

Figure 10 : l’onglet Propriétés du volet latéral quand un objet de dessin est sélectionné.

Modifier les dimensions des objets de dessin

Sélectionnez l’objet et cliquez sur une des poignées de sélection avant de la tirer jusqu’à la taille 
souhaitée. Pour maintenir les proportions, appuyez sur la touche Maj pendant le déplacement. 
Pour plus d’informations, voir « Placer, redimensionner et disposer les images », page 8.

Remarque

Les proportions ne sont pas conservées par défaut en tirant sur les poignées de coin : il faut 
donc toujours appuyer sur Maj pendant le déplacement pour conserver les proportions du 
dessin.

Grouper et dissocier des objets de dessin

La procédure est la même que pour les images : voir « Grouper et dissocier des images », page
11.
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Outils supplémentaires

Quelques outils supplémentaires sont accessibles dans le menu contextuel par un clic droit sur 
une image ou un objet de dessin.

Description
Vous pouvez adjoindre un titre et une description à une image ou à un objet de dessin. Ces 
informations sont utilisées par les outils d’accessibilité (comme les logiciels de lecture 
d’écran) et comme texte alternatif (attribut ALT) si le document est exporté en HTML.

Nom
Vous pouvez donner un nom personnalisé à une image ou à un objet de dessin pour le re-
trouver plus facilement dans le navigateur. Cela aide aussi à les identifier quand une équipe 
travaille sur le même classeur à plusieurs pages.

Pivoter ou retourner
Vous pouvez faire pivoter ou incliner une image ou un objet de dessin, ou retourner une 
image horizontalement ou verticalement.

Assigner la macro
Cette entrée ouvre la boîte de dialogue Assigner une macro qui vous permet d’ajouter une 
fonctionnalité programmée à l’image ou à l’objet de dessin. Calc dispose d’une très bonne 
fonction de macro. Pour plus d’informations, voir le chapitre 12, Macros.

Éditer l’hyperlien
Vous pouvez définir un hyperlien entre une image ou un outil de dessin et un autre emplace-
ment dans le classeur, un autre document ou une page web. Cette entrée ouvre la boîte de 
dialogue Hyperlien. Pour plus d’informations sur les hyperliens, voir le chapitre 10, Lier les 
données.

Compresser
Vous pouvez compresser les images pour réduire la taille du fichier qui contient le classeur. 
Sélectionnez Compresser dans le menu contextuel pour ouvrir la boîte de dialogue Com-
presser l’image qui vous permettra de paramétrer les options de compression. Cette option 
n’est pas disponible pour les objets de dessin.

Éditer avec un outil externe
Vous pouvez éditer une image avec un outil externe. L’application utilisée dépend des para-
mètres de votre ordinateur. Cette option n’est pas disponible pour les objets de dessin.

Utiliser Fontwork

Avec Fontwork, vous pouvez créer des objets graphiques d’art textuel pour embellir votre travail. 
Comme ces objets possèdent de nombreux paramètres différents (ligne, remplissage, position, 
taille, etc.), vous avez un large choix.

Fontwork est disponible dans tous les modules de LibreOffice, mais vous remarquerez de petites 
différences dans la manière dont chacun l’affiche.
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Créer un objet avec Fontwork

 1) Pour ouvrir la Galerie Fontwork, cliquez sur l’icône Galerie de Fontwork  dans la barre 
d’outils Fontwork (Affichage > Barres d’outils > Fontwork) ou la barre d’outils Dessin (Affi-
chage > Barres d’outils > Dessin).

 2) Dans la boîte de dialogue Galerie Fontwork (Figure 11), choisissez un style puis cliquez sur 
OK. L’objet de Fontwork va apparaître dans votre document.

Figure 11 : La galerie Fontwork

 3) Appuyez sur la touche F2 ou faites un double clic sur l’objet pour en modifier le texte (voir Fi-
gure 12). Sélectionnez le texte et tapez le vôtre à la place du mot Fontwork qui apparaît en 
noir par-dessus l’objet.

Figure 12 : Éditer le texte d’un objet Fontwork.

 4) Cliquez dans un espace vide ou appuyez sur la touche Échap pour appliquer les modifica-
tions.
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Modifier un objet de Fontwork

Maintenant que l’objet de Fontwork est créé, vous pouvez modifier certains de ses attributs. Pour 
cela, vous pouvez utiliser la barre d’outils Fontwork, la barre d’outils Formatage ou les options du 
menu. Pour plus d’informations, voir le chapitre 11, Images et Dessins, du Guide du Débutant.
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